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The Bulletin 

Number 2, Friday 17 February, 2023 

Inside this issue 

Here's what you'll find: 

• From SVRC: Message from the Manager, Teaching young children to use optical 
magnifiers, New Etext to the Library, Enabling Accessibility for Screen Readers in Google 
Docs, Extracting YouTube Transcripts 

• From the field: APH Video Tutorials, Report on PL day, Master of Inclusive Education 
Program 2023, Graduate Certificate in Education (Learning Difficulties) 

PD events 
The 2023 Professional Learning Calendar is now available for download on our website. See below 
for links to the events in Term 1 2023. 

Tuesday February 21 Inclusion of students who have low vision 

Providing practical strategies for classroom teachers and ES staff to promote inclusion and 
achievement for their students who have low vision. 

Tuesday March 7 Inclusion of students with vision impairments and additional disabilities 

Providing practical strategies that teachers and ES staff can use to support students with a vision 
impairment and additional disabilities. 

On Demand PL 

All of our professional learning workshops are now available on demand where participants can 
access all the videos and resources at a time that suits them. You can find links through the On 
Demand page, under Professional Learning, on our website. 

  

http://www.svrc.vic.edu.au/
https://www.svrc.vic.edu.au/s/2023-SVRC-PL-Calendar.pdf
https://www.svrc.vic.edu.au/pro-learning-events/https/wwweventbritecomau/e/inclusion-of-students-who-have-low-vision-tickets-194127629967-fgezj
https://www.svrc.vic.edu.au/pro-learning-events/https/wwweventbritecomau/e/inclusion-of-students-with-vision-impairments-and-additional-disabilities-tickets-194129525637-gkb3c
https://www.svrc.vic.edu.au/on-demand
https://www.svrc.vic.edu.au/on-demand
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Message from the Manager 
Source: Kim Foley, Manager, SVRC 

PROTECT Child Safety Standards  

New Child Safe Standards were introduced on 1 July 2022. Guidance and resources have been 
developed to support schools transition to the new Standards. The department's PROTECT website 
contains guidance to support schools to implement the new Child Safe Standards including a new 
Child Safe Standards Action List for government schools. 

SVRC PROTECT Child Safety Standards policies have been reviewed for compliance with the 
Department of Education. If your child attends Support Skills or DOT Power, please familiarise 
yourself with our policies on our website, they're under About, Policies. It is important that SVRC is 
a safe environment for teaching, learning and working for all students, staff, and parents. All SVRC 
staff will attend PROTECT Child Safety Standards professional learning sessions as part of these 
designated compliance standards. If you would like a copy of SVRC policies in print or braille please 
place a request with our administration office. 

SVRC-VTS-Vision Community of Practice  

On Monday, our first Visiting Teacher – Vision Community of Practice session was held, and we 
had the privilege of listening to the highly distinguished Professor Cay Holbrook. Cay Holbrook 
began her career as a teacher of students with visual impairments (TVI) during her undergraduate 
pre-service teacher training program at Florida State University. She continued to teach students 
in Georgia, South Carolina and Florida while she completed her masters and doctoral degrees, also 
at Florida State University.  Her doctoral dissertation focused on the perceived role of the teacher 
of students with visual impairments and she has remained interested in questions regarding 
service delivery and educational supports and curriculum for this population. Cay moved to 
Vancouver in 1998, British Columbia to join the faculty at The University of British Columbia where 
she is now. 

Along with her dear friend and professional collaborator, Alan Koenig, Cay worked on defining a 
process to determine learning and literacy media for students with visual impairments through a 
data-driven collaborative team approach called Learning Media Assessment. This process resulted 
in one of twelve textbooks that have been written or edited by Cay and her collaborators.  These 
textbooks include, two editions of Children with Visual Impairments: A Parents' Guide, two 
editions of Foundations of Education for Students with Visual Impairments (Volumes 1 and 2), and 
support for teachers' learning and using braille, The Braille Enthusiasts' Dictionary (EBAE and UEB 
versions), and Ashcroft's Programmed Instruction in Braille (EBAE and UEB versions). 

Cay’s presentation focussed on the "twelve things she knows" about effective development of 
braille literacy skills and the how and when for developing dual medium skills. Her delivery was 
passionate, thought provoking and extremely knowledgeable on best practice strategies and skills 
to support our students who are blind or have low vision.  

Support Skills Program  

Support Skills Program was held last Friday with many new students joining us for the first time. It 
was wonderful to watch the students grow in confidence and independence in navigating an 
individual timetable, orientating themselves around the building to different learning spaces and 

http://www.svrc.vic.edu.au/
https://www.education.vic.gov.au/Documents/about/programs/health/protect/2022_CSS_Action_list_gov_schools.docx
https://www.education.vic.gov.au/Documents/about/programs/health/protect/2022_CSS_Action_list_gov_schools.docx
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exploring the school playground areas. During the afternoon sessions, Blind Sports and Recreation 
volunteers introduced blind tennis to staff and students and lots of fun was had by all. 

Teaching young children to use optical magnifiers 
Source: Marion Blaze 

Magnifiers are very handy tools for our students to have in their pockets. They are small, portable, 
inexpensive and can be on hand when the need arises. If your student has skills with a magnifier, 
they don’t need to wait for something to be photo-enlarged. This is a handy skill for the future. 

Like glasses, they should be prescribed by a low vision specialist. This will ensure they are the right 
fit for the student’s vision, especially if the student wears glasses. It’s useful to know if the 
magnifier is prescribed to be used while wearing glasses, and with which eye. 

Some things to know about magnifiers: 

• The bigger the magnifier, the less it magnifies 

• The child must look through the centre of the magnifier. Beyond the central area, the 
image will be distorted. 

• Magnifiers reduce the visual field. To maximise the visual field or span when looking 
through a magnifier, the eye needs to be close to the magnifier. Don’t forget, young eyes 
can focus very close. 

• Some magnifiers are meant to sit on the page, such as dome or stand magnifiers, whereas 
"hand-held" magnifiers are held above the page and focus can be adjusted by moving it 
closer or further from the page. 

• Because a child’s eye needs to be close to the magnifier, it might be helpful for them to use 
a reading stand or tilt board, so they are not bending over their work. 

• Magnifiers get scratched and always in the very centre which is the part one looks through. 
It’s handy to keep them in a velvet pouch. 

Try your student’s magnifier to better understand how it works and the challenges your student 
might face: 

1. Time your own reading of a passage and calculate words-per-minute rate. 
a. Time again, using the magnifier – compare the times for each mode of reading. 
b. With practice your student should be able to increase their reading speed using the 

magnifier, but there might still be visual fatigue. 
2. Compare "functional fields" or "perceptual spans" by counting the number of words or 

letters that you can see clearly at one time with your eye and then with the magnifier. 
3. Check the motion effects caused by using the magnifier when you scan. 
4. Check the ease with which you can locate the next line of print. 
5. Try using the magnifier whilst the print is on a reading stand. 
6. Look up a word in a dictionary using only the magnifier. 
7. Read the recommended dosage on a bottle of tablets. 

  

http://www.svrc.vic.edu.au/
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Activities using a magnifier 

With Preschool/Primary school students 

1. Observe interesting objects: rocks, shells, fossils, feathers, money, fingerprints, leaves, 
flowers, own fingernails, and so on. 

2. Use a magnifier to identify stamps and find out the country of origin in an atlas or on a 
globe. 

3. Use a game board approach to move forward when cut-out pictures on individual cards are 
identified. 

4. Find hidden pictures within pictures. Where’s Wally? 
5. Read recipes or cooking instructions on food boxes. 
6. Life skills reading activities: include reading the following: recipes, menus, newspapers, CD 

covers, food cans, maps, charts, graphs, bus schedules. 
7. Read Lego assembly instruction sheets to Lego toys. 
8. Place magnifier on mirror to observe eyes and open up discussion about the child’s vision. 

With Secondary school students 

1. Scan spreadsheet printouts for specific information. 
2. Read newspaper classified sections, sports pages, and stock reports to search for specific 

information. 
3. Locate information about food ingredients on grocery labels. Some teenagers are 

interested in the nutritional or calory information. 
4. Read bus and train schedules to plan routes to and from school or a work experience 

placement. 
5. Make a chart to compare reading speeds using magnifier with different sized print. 
6. Read instruction manuals for computers or new gadgets. 
7. Use a magnifier to locate geographic areas on a map mentioned in current news 

broadcasts. 

Here ae some links to further activity ideas: 

Family Connect: Fun Activities for Teaching Magnifier Use 

Paths to Literacy: Magnifier Activity for Pre-Readers 

  

http://www.svrc.vic.edu.au/
https://familyconnect.org/education__trashed/literacy/fun-activities-for-teaching-magnifier-use/
https://www.pathstoliteracy.org/magnifier-activity-pre-readers/
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New Etext to the Library 

For the Younger Reader: The Undys 

Written by Michael Wagner, author of the Maxx Rumble books, "The Undys" is a series of six 
books for readers who are beginning to enjoy early chapter books.  

Centred around the two main characters, Phil a single-father (shown left) and his son Josh (right), 
there is plenty of action and slapstick humour that may engage the reluctant reader! 

From kids-bookreview.com:  

"Phil may be a bumbling fool at times, but what more could a 
young lad need? Someone to laugh with, someone to play with, 
someone to compete with – because competition is the 
backbone of the Undy relationship. 

It's all about the game with this pair – from Gut Barging and 
Toe-Wrestling to Run 'Til You Stop, each is intent on outdoing 
the other." 

I must confess, these books did make me smirk! 

Books in "The Undys":  

1. Let the Games Begin 
2. Let's Get Physical (if you have a print copy of this book, please send it along!) 
3. Itching for Action 
4. Wet and Wild 
5. One Wacky Week 
6. On the Move 

For the Older Reader: Dry by Neal Shusterman and Jarrod Shusterman 

There has been a drought in California for quite a while, but then the taps actually run dry ... 

From thenerddaily.com: "Dry is an action movie trapped inside the pages 
of a book. A story that will take your breath away to such a point that you 
will find yourself gasping for air in the most critical points of the 
characters’ journey. The pace of this novel is incredibly dynamic, moving 
from scene to scene with precision and ease. Thanks to the different 
snapshot fragments they include between chapters to show the 
consequences of the water crisis from as many perspectives as possible, 
the narrative structure perfectly mimics the buildup of takes that 
conform a cinematic production. At the same time, for a novel that is 
basically plot-driven, the main characters are fully developed, each with a 
set of traits and skills that complement those of the others at the most 
necessary times. 

Action-packed with the raw and desperate tone of a world in shambles, the California in the brink 
of apocalypse that Neal and Jarrod Shusterman create is nothing but worryingly believable."  

http://www.svrc.vic.edu.au/
http://1.bp.blogspot.com/-inYjZSERGDw/To9wbP8UBKI/AAAAAAAAb5U/iJGQsTwjhqU/s1600/undys+Fillmore.jpg
http://1.bp.blogspot.com/-het66HAdkBY/To9wcfJVWwI/AAAAAAAAb5c/bcYFAuspRJE/s1600/undys+Josh.jpg
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Enabling Accessibility for Screen Readers in Google Docs 
When using Google Docs with a screen reader the user needs to initially enable screen reader 
support. 

Use a screen reader 

If you already use screen reader software on your computer, such as ChromeVox, NVDA, JAWS or 
VoiceOver, follow these steps to get started. 

Step 1: Turn on screen reader support 

The first time you use Google Docs, Sheets or Slides with a screen reader, you need to turn on 
screen reader support: 

1. Go to Google Docs, Sheets or Slides and open a file. 

2. In the Tools menu, select Accessibility settings. 

3. Select Turn on screen reader support. 

Step 2: Check your screen reader settings 

For some screen readers, you might need to adjust your settings when you use Google Docs, 
Sheets, Slides or Drawings. Check your screen reader instructions below. 

NVDA 

On Windows, for the best experience, use the latest version of NVDA with the latest version of 
Chrome or Firefox. 

Docs, Slides and Drawings 

1. Go to Google Docs, Slides or Drawings and open a file. 

2. Listen for these words: "Screen reader support enabled". If you don't hear anything, go to 

the Tools menu, select Accessibility settings, then select "Turn on screen reader support". 

You should hear "Screen reader support enabled". 

3. Press NVDA + Ctrl + K, then turn off Speak typed characters and Speak typed words. 

4. Optional: Change your NVDA startup keyboard shortcut so that it doesn't conflict with 

Docs, Slides or Drawings. The default NVDA keyboard shortcut, Ctrl + Alt + n, is commonly 

used in Docs, Slides or Drawings (for example, Ctrl + Alt + n then g navigates to the next 

image in a document). To change your NVDA keyboard shortcut, open Properties from the 

NVDA shortcut. On the Shortcut tab, edit the Shortcut key so that it doesn't conflict with 

Docs, Slides or Drawings (for example, Ctrl + Alt + \). 

Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

Tip: Focus mode generally provides a better experience than browse mode. To switch between 
focus and browse modes, press NVDA + Spacebar. 

On Windows, for the best experience, use the latest version of JAWS with the latest version of 
Chrome or Firefox. 

http://www.svrc.vic.edu.au/
https://docs.google.com/document/
https://docs.google.com/spreadsheets/
https://docs.google.com/presentation/
https://docs.google.com/document/
https://docs.google.com/spreadsheets/
https://docs.google.com/presentation/
https://docs.google.com/document/
https://docs.google.com/presentation/
https://docs.google.com/drawings/
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JAWS 

Docs, Slides and Drawings 

For Docs, Slides and Drawings, follow these steps to adjust your JAWS settings: 

1. Go to Google Docs, Slides or Drawings and open a file. 

2. Listen for these words: "Screen reader support enabled". If you don't hear anything, go to 

the Tools menu, select Accessibility settings, then select Turn on screen reader support. 

You should hear "Screen reader support enabled". 

3. If you use Firefox: 

• Set key echoing to no echoing: Press JAWS + 2 until you hear "None". 

• Turn off the virtual cursor: Press JAWS + Z until you hear "Use virtual PC cursor off". 

Then press JAWS + Z + Z until you hear "The virtual cursor will be turned off for all 

applications". 

• Adjust forms options: Make sure that the focus is on the top toolbar, then press JAWS + 

V. In the settings window, search for "Forms options" and untick both "Auto forms 

mode" and "Forms mode off when new page loads". Then press OK. 

• Tab from the address bar through the Docs toolbar controls until you hear application 

mode announced, then press Escape to return to the editing area. 

Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

Tip: Forms mode generally provides a better experience than virtual mode. 

VoiceOver 

Google Docs, Sheets, Slides and Drawings are compatible with VoiceOver on the latest version of 
macOS. The recommended browser is Google Chrome. 

For the best experience, turn off VoiceOver's quick nav feature by pressing the left and right 
arrows at the same time. 

Docs, Slides and Drawings 

1. Go to Google Docs and open a document. 

2. Listen for these words: "Screen reader support enabled". If you don't hear anything, go to 

the Tools menu, select Accessibility settings, then select Turn on screen reader support. 

You should hear "Screen reader support enabled". 

3. If you've turned on "Automatically speak the webpage" in VoiceOver, you'll hear the screen 

reader. Press Escape to return your focus to the editing area. 

4. Press VoiceOver + Shift + Down arrow to interact with the editable text. 

Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

  

http://www.svrc.vic.edu.au/
https://docs.google.com/document/
https://docs.google.com/presentation/
https://docs.google.com/drawings/
https://docs.google.com/document
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Keyboard shortcuts and VoiceOver 

VoiceOver shortcuts conflict with menu shortcuts for Google Docs, Sheets, Slides and Drawings. To 
open the menus, first use the VoiceOver pass-through keys Ctrl + Option + Tab, then type the 
menu shortcut, such as Ctrl + Option + f for the File menu. You can also quickly search the menus 
by pressing Option + / then searching for a term such as "File". 

If VoiceOver doesn't automatically focus on the correct part of the page (for example, if a dialogue 
window appears), press Escape to return your focus to the editing area. Then press VoiceOver + 
Shift + Down arrow to return to the editing area 

Step 3: Start editing 

Extracting YouTube Transcripts 
Did you know that you can extract transcripts from the audio file of a YouTube video? This can be 
a really useful tool for getting instructions or commands from an instructional video for assistive 
devices or software. 

When the YouTube video is open there are 3 little dots at the right hand bottom side, click this 
(JAWS – B for button or control + Insert + B for button list) and the list of options will show 
navigate to "Show transcript". 

 
The transcripts will populate in a window beside the video which displays time stamps for the 

video, the text can then be selected and copied into a document and edited. 

 

http://www.svrc.vic.edu.au/
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APH Video Tutorials 
American Printing House for the Blind (APH) offer a wide range of Video tutorials and on demand 
webinars for FREE. Playlists can be sorted by topic areas. Here's a link to the APH's Youtube 
Channel for to you explore. 

Report on PL day – Inclusion for students who are blind 
SVRC hosted our first online professional learning day on Tuesday, February 14, 2023 for 37 
participants. There were some teams from some schools, both near and far. Presenters included 
Di Bennett on making materials accessible and iPads apps, Jordie Howell on living with braille, 
Kirstie Price on orientation and mobility training and Geoff Bowen on individual, social and family 
perspectives. We also heard from a student, now in University. It was great to have some curious 
people following up with questions and requests for further training. 

Here are some useful "tips" shared on the day: 

• write a map or shape on a student’s back to explain a route or a shape 

• plan ahead – think about what you’ll be teaching and any materials you will need 

• use "reader view" to make websites more accessible 

• senior students can set up a shared drive with all their teachers to keep in touch 

Thank you to Naomi for all the Eventbrite set-up before she went on her teaching placement, 
Michael for running all the technology including recordings and Sarah for monitoring the chat and 
answering questions along the way. What a team!! 

Master of Inclusive Education Program 2023 
Source: Inclusive Education Scholarships Unit, Department of Education 

Are you interested in gaining a department-funded master’s level qualification specialising in 
vision impairment or inclusive education? Applications for Round 9 (R9) are now open and will 
close on Tuesday 28 March at 11:59 pm. The long-term vision is for all Victorian government 
schools to have a master-level qualified inclusive education teacher on staff, creating and leading a 
more inclusive school environment for all students regardless of their abilities and backgrounds. 

There are 75 places available, and the program will consider providing schools with an additional 
masters if teachers are interested in specialising in vision impairment, through the following 
course: 

• NextSense - Macquarie University: Master of Disability Studies - Blindness/Low Vision 

For all other Inclusive Education courses, please see course details below: 

• Australian Catholic University: Master of Education (Inclusive Practice) 

• Deakin University: Master of Specialist Inclusive Education 

• La Trobe University: Master of Education (Inclusion and Diversity) 

• Monash University: Master of Applied Behaviour Analysis 

• Monash University: Master of Inclusive Education 

http://www.svrc.vic.edu.au/
https://www.youtube.com/@AphOrg/playlists
https://www.youtube.com/@AphOrg/playlists
https://www.nextsense.org.au/professional-development/postgraduate-study
https://www.acu.edu.au/course/master_of_education
https://www.deakin.edu.au/course/master-specialist-inclusive-education
https://www.latrobe.edu.au/courses/master-of-education
https://www.monash.edu/study/courses/find-a-course/2022/applied-behaviour-analysis-d6015
https://handbook.monash.edu/2021/courses/D6014?year=2021
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• University of Melbourne: Master of Learning Intervention Stream A 

• University of Newcastle: Master of Special and Inclusive Education 

Through additional postgraduate study, teachers can make a significant contribution to how their 
schools plan and support students with disability and additional learning needs, using 
contemporary evidence-based, best practice approaches. These bespoke courses have been 
designed for the Victorian context and will be delivered by our seven partnered universities listed 
above. Please see the Master of Inclusive Education website for further information, including 
testimonials from graduates of the program. 

To find out more or to check whether your school is eligible, please contact the IESU at: 
inclusive.ed.scholarships@education.vic.gov.au or call 9084 8496. 

Graduate Certificate in Education (Learning Difficulties) 
Source: Inclusive Education Scholarships Unit, Department of Education 

Strengthen your knowledge of learning difficulties, including dyslexia and dyscalculia, with 
postgraduate study in 2023. 

The Department is offering 75 fully funded places for learning specialists, leading teachers, and 
classroom teachers working in mainstream Victorian government primary or secondary schools to 
undertake the Graduate Certificate in Education (Learning Difficulties) program, commencing 
study in Semester 2, 2023. 

Delivered by the Melbourne Graduate School of Education at the University of Melbourne, this 
bespoke course is designed for the Victorian educational context. 

Applications for Round 2 opens are now open and will close on Tuesday 28 March at 11:59 pm. 
Visit the Graduate Certificate webpage for more information about eligibility and how to apply. 

And finally… 
Did you know that exploring audio descriptions for Art is part of Version 9 of the Australian 
Curriculum? It can be found as an elaboration in Visual Art, Exploring and Responding in Year 5-6. 

http://www.svrc.vic.edu.au/
https://study.unimelb.edu.au/find/courses/graduate/master-of-learning-intervention/
https://www.newcastle.edu.au/degrees/master-special-inclusive-education/handbook
mailto:inclusive.ed.scholarships@education.vic.gov.au
https://www.education.vic.gov.au/school/teachers/learningneeds/Pages/graduate-certificate-in-education-learning-difficulties-program.aspx
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